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Abstrakt 

Předmětem této bakalářské práce je vytvoření přesného 3D modelu dvou chodeb a 

podkroví v části budovy FEL ČVUT na Karlově náměstí. Součástí práce je i popis 

teoretických základů 3D grafiky, počínaje světlem a jeho chováním v přírodě i ve 

virtuální realitě, dále Phongovým osvětlovacím modelem a základními algoritmy syntézy 

obrazu. Postup práce je stručně zdokumentován a vytváří jakýsi tutoriál. Při modelování 

je kladen velký důraz na přesnost rozměrů, autentičnost přiřazených materiálů a reálné 

nasvícení scény. Práce bude slouţit pro simulování světelných podmínek ve 

vymodelovaných prostorech, především pro budoucí pouţití rozšířené realit. Vytvořený 

model bude moţné procházet v softwaru VRUT dodaném ČVUT. Výsledkem je projektu 

je porovnání pořízených fotografií s výstupem modelovacího softwaru i dodané aplikace 

VRUT. 

 

 

 

Abstract 

The purpose of this bachelor thesis is to create 3D model of two corridors and a loft in 

section of building FEE CTU near Karl’s square. Description of theoretical basics in 3D 

graphic, including light and his behavior in a nature, Phong illumination model and basic 

algorithm are used for rendering is also part of the thesis. The progress of work is 

documented and made a tutorial. It is put emphasis on measuring accuracy, authenticity 

of used materials and realistic illumination of the scene. The thesis will be used for 

simulating illumination conditions in the modeled scene, mainly for future simulation 

applied in augmented reality. The software called VRUT, supplied by CTU, should be 

used for walking through the model. The result of the project is comparison of real photos 

with renders form software used for modeling and with renders from VRUT application. 

 

 

 

  



  

 

 

 

 

  



  

 

 

OBSAH 

1. ÚVOD ....................................................................................................................... 1 

2. OSVĚTLENÍ V 3D GRAFICE .............................................................................. 3 

2.1 CHOVÁNÍ SVĚTLA V PŘÍRODĚ ................................................................................. 3 
2.2 CHOVÁNÍ SVĚTLA V 3D GRAFICE ........................................................................... 3 
2.3 STÍNOVÁNÍ ............................................................................................................. 4 

2.4 PHONGŮV OSVĚTLOVACÍ MODELY ......................................................................... 5 
2.5 ZDROJE SVĚTLA V 3D GRAFICE .............................................................................. 9 

3. RENDEROVÁNÍ V 3D GRAFICE ..................................................................... 11 

3.1 LOKÁLNÍ A GLOBÁLNÍ OSVĚTLENÍ ........................................................................ 11 

3.2 ALGORITMY VÝPOČTU OSVĚTLOVACÍCH MODELŮ ............................................... 11 

4. POUŢITÝ SOFTWARE ...................................................................................... 13 

4.1 AUTODESK MAYA 2013 ....................................................................................... 13 
4.2 VRUT (VIRTUAL REALITY UNIVERSAL TOOLKIT) .............................................. 14 

5. REALIZACE PROJEKTU .................................................................................. 15 

5.1 POSTUP REALIZACE PROJEKTU ............................................................................. 15 
5.2 MĚŘENÍ A PŘÍPRAVA PODKLADŮ K MODELOVÁNÍ ................................................. 15 
5.3 MODELOVÁNÍ ...................................................................................................... 18 
5.4 MATERIÁLY MODELU ........................................................................................... 22 

5.5 OSVĚTLENÍ MODELU ............................................................................................ 24 
5.6 RENDEROVÁNÍ MODELU POMOCÍ MENTAL RAY .................................................... 26 
5.7 TESTOVÁNÍ MODELU V APLIKACI VRUT .............................................................. 26 

6. POROVNÁNÍ VÝSLEDKŮ ................................................................................. 31 

7. ZÁVĚR................................................................................................................... 33 

SEZNAM POUŢITÉ LITERATURY ......................................................................... 35 

PŘÍLOHY: 

A: UKÁZKA MODELŮ .................................................................................................... 37 

B: VÝSTUPY Z RENDERERU MENTAL RAY ..................................................................... 41 
C: VÝSTUPY Z APLIKACE VRUT .................................................................................. 47 
D: SEZNAM POUŢÍVANÝCH ZKRATEK ........................................................................... 51 
E: OBSAH PŘILOŢENÉHO DVD ..................................................................................... 53 

 

  



  

 

 

 

  



  

 

 

SEZNAM OBRÁZKŮ 

 

Obr. 1 Porovnání různých algoritmů stínování. [4] ..……..…  5 

Obr. 2 Schéma Phongova osvětlovacího modelu. [20] …………  6 

Obr. 3 Porovnání objektů s různými typy odrazů. …………  8 

Obr. 4 Porovnání (a) plošného světla a (b) bodového světla. 

[20] 

 

…………  9 

Obr. 5 Světelné zdroje v 3D grafice. [15] ………... 10 

Obr. 6 Porovnání (a) lokálního a (b) globálního osvětlení. ………... 11 

Obr. 7 Schéma algoritmu (a) ray casting a (b) ray tracing. [9] ……...… 12 

Obr. 8 Podklady k modelování s naměřenými hodnotami. ……...… 16 

Obr. 9 Úprava textur v aplikaci Zoner Photo Studio. (a) 

Původní fotografie. (b) Fotografie po úpravě, tedy 

připravená textura. 

 

 

…...…… 17 

Obr. 10 Hierarchie objektů ve scéně. …...…… 19 

Obr. 11 Detail různých zakončení modelů lišt. …...…… 20 

Obr. 12 Přehled materiálů pouţitých v modelu. ……...… 22 

Obr. 13 Ukázka nastavení závislosti úhlu pohledu na odrazu: 

(vlevo) úhel pohledu 0 ° a nulový odraz. (vpravo) Úhel 

pohledu 90 ° a vysoká odrazivost materiálu. [27] 

 

 

……...… 23 

Obr. 14 Render topení z modelovaných prostor s ukázkou 

válcovitého mapování textury. 

 

……...… 24 

Obr. 15 Porovnání světelných podmínek. (a) Scéna pouze se 

směrovým světelným zdrojem. (b) Scéna se směrovým 

světlem a přídavným bodovým světlem. 

 

 

……...… 25 

 

 

 

 

 

 

 

 



  

 

 

Obr. 16 Porovnání kvality a autentičnosti osvětlení (a) pouze 

plošnými světly umístěnými v oknech, (b) bodovými 

světly (c) a plošnými světly umístěnými v oknech 

v kombinaci se stěnami emitující světlo. 

 

 

 

………... 29 

Obr. 17 (nahoře) Fotografie (uprostřed) výsledek z mental ray 

(dole) výsledek VRUT. 

 

……...… 30 

 

 



  

1 

 

1. ÚVOD 

Rozšířená realita (augmented reality) je technologie kombinující virtuální objekty 

s objekty reálného světa. Rozšířená realita tedy funguje na principu, kdy je pomocí 

snímače získáván obraz reálného prostředí a současně je ve výpočetním zařízení mixován 

tento obraz nejčastěji s 3D modely. V dnešní době uţ tato technologie není jen 

experimentální, ale pouţívá se např. i pro studijní účely, v reklamě a nebo v zábavním 

průmyslu. K pouţití této technologie je potřeba počítač a záznamové zařízení. 

V posledních letech se s vývojem chytrých telefonů dostala rozšířená realita do povědomí 

běţných uţivatelů. Příkladem mohou být mobilní aplikace, které za pomoci signálu GPS 

a digitálního kompasu dokáţí do videa pořízeného mobilním telefonem zakomponovat 

např. budovy a podobné objekty. Pro správnou funkčnost rozšířené reality je velice 

důleţitá tzv. registrace. Registrací je míněna vzájemná poloha virtuálních a skutečných 

objektů a jejich umístění ve scéně. [5] 

Pro budoucí pouţití rozšířené reality v prostorách budovy FEL ČVUT na Karlově 

náměstí je třeba vytvořit přesné modely prostor, které pak budou moci nahradit skutečné 

objekty. Pro realizaci modelu prostor, byl zvolen program Autodesk Maya 2013 se 

studentskou licencí. 
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2. OSVĚTLENÍ V 3D GRAFICE 

2.1 Chování světla v přírodě 

Světlo je elektromagnetické záření, ale zároveň má i charakter částic. Jedná se o 

tzv. duální povahu světla. Kaţdá z obou povah je vhodná pro vysvětlení různého chování 

světla. Je-li světlo povaţováno za vlnění, lze dokázat jevy jako disperze, difrakce a 

interference světelných paprsků. Pokud se světlo povaţuje za částice, tak lze naopak 

vysvětlit chování, jako jsou odrazy, ať uţ zrcadlové nebo mnohonásobné. [1] Důleţitou 

informací jsou děje, které se se světlem mohou v přírodě odehrávat. Absorpce (pohlcení), 

reflexe (odráţení), refrakce (lom) a fluorescence. První tři jmenované děje jsou v přírodě 

zcela běţné. Jednoduchým příkladem, na kterém lze tyto jevy ukázat je např. čiré sklo, ve 

kterém se část paprsků pohltí, část se odrazí a značná část jich projde skrz materiál. 

S fluorescencí se v přírodě příliš často nesetkáváme. Jedná se o chemicko-fyzikální jev, 

při kterém fluorescenční objekt pohltí záření, pro člověka neviditelné spektrum světla, a 

sám na základě takto získané energie emituje jiné záření o jiné vlnové délce. Pokud 

objekt emituje fotony i potom, co přestal být ozařován, tak tento jev nazýváme 

fosforescence. Jako příklad lze uvést některé volně se vyskytující minerály, které po 

dopadu ultrafialového záření vytváří záření v části spektra, které je pro lidské oko 

viditelné. [19] Takovými úkazy se v běţném ţivotě často nesetkáváme. 

Lidské oko je schopno vnímat záření s vlnovými délkami v rozmezí od 380 aţ po 

720 nanometrů, tj. od fialové barvy, aţ po barvu červenou. To, jakou barvu budeme mít 

předmět, na který se člověk dívá, záleţí na tom, jaké vlnové spektrum záření tento objekt 

pohlcuje a odráţí, popř. sám vyzařuje, jedná-li se o světelný zdroj. Barvu objektů, které 

samy nejsou světelným zdrojem, samozřejmě ovlivňuje i barva světla na ně dopadajícího. 

Dalším faktorem, určující barvu objektu, je úhel pozorování. 

2.2 Chování světla v 3D grafice 

V počítačové 3D grafice je snaha napodobit chování světla reálného světa. Aby 

však bylo moţné chování světla v přírodě s ohledem na výpočetní techniku simulovat, je 

třeba počítat s některými předpoklady. Za prvé, světlo se šíří přímočaře. Za druhé, 

rychlost šíření světla je nekonečná tzn., ţe v okamţiku rozsvícení světelného zdroje v 3D 
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prostoru je všudypřítomné. Světlo v počítačové grafice není nijak ovlivňováno 

elektromagnetickým polem apod. Počítačová grafika se opírá o znalosti radiometrie, tato 

fyzikální oblast zabývající se měřením elektromagnetického záření je na rozdíl od 

fotometrie nezávislá na člověku. [1]  

2.3 Stínování 

Stínování je vlastně vykreslování povrchů objektů různými odstíny barvy podle 

toho jak na něj dopadají paprsky světelného zdroje a tím je dán trojrozměrný vjem 

objektu. Objekty mohou být v 3D grafice reprezentovány buďto polygony, NURBs (Non-

Uniform Rational B-Splines) nebo subdivisions. Polygon neboli mnohoúhelník, je tvořen 

konečným počtem vrcholů (vertices) a hran mezi jednotlivými vrcholy (edges). Kaţdý 

vrchol má svoji vlastní normálu, podle které se vypočítává stínování. Hrana je přímá a je 

tvořena vţdy dvěma vrcholy, polygon je tvořen minimálně 3 hranami, resp. vrcholy. 

V terminologii pouţívané v 3D grafice je polygon nazýván také ploškou (face). Síť 

polygonů, kdy sousední polygony mají společné body a sdílejí hranu, tvoří polygonální 

objekt, často nazýván jako mesh. Soustavě polygonálních objektů se říká model. [26] 

NURBs je geometrie tvořená křivkami a plochami. Křivky jsou tvořeny řídícími body, 

jejich poloha, resp. rozmístění určuje tvar a zakřivení křivky. Výhodou křivek a ploch 

jimi tvořenými je jednodušší reprezentace zakřivených ploch neţ pomocí polygonů, 

kterých by bylo k dosaţení stejné a hladké plochy potřeba větší počet. Subdivision objekt 

je typ geometrie, který spojuje výhody jednoduchosti polygonálního modelování a tvorby 

modelů pomocí NURBs. Je vhodný pro modelování hladkých a zakřivených tvarů 

podobně jako NURBs, ale lze ho transformovat pomocí řídících bodů umístěných na 

mříţi v okolí objektu. 

V 3D grafice existuje několik technik stínování objektů. Mezi ty nejčastěji 

pouţívané patří algoritmy konstantního stínování, Gouraudova stínování a Phongova 

stínování. Jmenované techniky stínování budou vysvětleny na objektech tvořených 

polygony.  

Základní technikou je konstantní stínování, kdy kaţdá plocha je povaţována za 

rovinu. [13] Z  toho vyplývá, ţe normály budou v bodech této plochy kolmé k jejímu 

povrchu V osvětlovacím modelu bude mít kaţdá plocha jen jednu určitou barvu.  
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Gouraudova interpolační metoda stínování je pokročilejší. Barva je vypočítána pro 

kaţdý vrchol hrany daného objektu. Následně jsou získané intenzity barev na ploše hrany 

interpolovány. Jinak řečeno jsou mezi jednotlivými vrcholy vytvořeny přechody z takto 

získaných barev. 

Phongovo stínování je z výše uvedených metod nejdokonalejší. Zde dochází 

nejprve k interpolaci normálových vektorů vrcholů, resp. zprůměrování normálových 

vektorů, v kaţdém vrcholu hrany a aţ potom je pro kaţdý pixel vypočítána jeho barva. 

 

 

Obr. 1 Porovnání různých algoritmů stínování. [4] 

2.4 Phongův osvětlovací modely 

Phongův osvětlovací model patří mezi empirické modely. [9] Výsledné osvětlení, 

které vidí pozorovatel, resp. je snímáno imaginární kamerou, vzniká odrazy od objektů. 

Intenzita osvětlení, resp. jednotlivých paprsků je určena parametrem „I“, který je vţdy 

tvořen intenzitami základních barev aditivního míšení, tj. červenou, zelenou a modrou 

barvou (vzorec 2.1). [13] 

 

I = (Ir , Ig , Ib) (2.1)  

kde Ir/g/b = intenzity základních barev (red, green, blue) 

 

http://cs.wikipedia.org/wiki/Phong%C5%AFv_osv%C4%9Btlovac%C3%AD_model
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Obr. 2 Schéma Phongova osvětlovacího modelu. [20] 

 

Na obr. 2 je schematicky zobrazen pozorovatel modrou tečkou a zdroj světla ţlutou 

tečkou. Ty mají své vektory, které určují směr pohledu a směr dopadajícího světla na 

objekt. Černou barvou je znázorněn povrchu objektu, který má svůj normálový vektor 

„N“, kolmý na povrch. Vektor „R“ zastupuje spekulární odraz. 

Ambientní neboli okolní světlo je konstantní světlo po celém povrchu objektu. 

Ambientní osvětlení se vypočítá jako součin intenzity okolního osvětlení a koeficientu 

odrazivosti materiálu (vzorec 2.2). [13] Toto světlo bývá v 3D scéně často konstantní pro 

většinu materiálů, protoţe imituje světlo několikanásobně odraţené od ostatních objektů.  

 

Ca = Ia . ka (2.2) 

kde Ca = ambientní osvětlení 

  Ia = intenzita okolního osvětlení 

  ka = koeficient odrazivosti materiálu 

 

Difuzní odraţené světlo je typické pro materiály s matným nebo hrubším 

povrchem. Na takovýchto površích směřují normály různými, náhodnými směry. [2] 

Difuzní světlo se řídí Lambertovým osvětlovacím modelem. [10] Tento model totiţ na 

rozdíl od Phongova pracuje pouze s ambientním difuzním světlem. Odraz nezávisí na 

vektoru pozorovatele, ale jen na směru světelných paprsků. Lambertův zákon totiţ říká, 

ţe světlo je izotropní, tzn., ţe se do všech směrů odráţí se stejnou intenzitou. [3] Budeme-

li si tedy prohlíţet scénu z jakéhokoliv místa, tak osvětlení objektů se měnit nebude. Pro 

Lambertův model platí, ţe intenzita odraţeného světla je rovna součinu intenzity 

I 
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difuzního světla, koeficientu odrazivosti materiálu a cosinu úhlu svírající vektor pohledu 

a normálový vektor místa dopadu světla. Pro výpočet difuzního odrazu lze cosinus 

nahradit součinem vektoru světla a normálového vektoru (vzorec 2.3). [13] 

 

Cd = Id . kd . (L . N) [2] (2.3) 

kde Cd = difuzní osvětlení 

  Id = intenzita difuzního osvětlení 

  ka = koeficient odrazivosti materiálu 

 

Spekulární světlo vzniká typicky na hladkém povrchu materiálů, jako je např. kov, 

sklo apod. Na obr. 2 je vidět reálné chování tzv. spekulárního odrazu. Ani v přírodě se 

nevyskytuje naprosto dokonalé zrcadlo, a tak vţdy se nějaká část paprsků rozptýlí – viz. 

krátké šipky okolo normálového vektoru na obr. 2. Nejedná se o difuzní odraz světla. 

Tento nedokonalý odraz, který vzniká na hladkých površích, objevil počítačový grafik 

Phong Bui-Tuong, po kterém také nese název celý osvětlovací model. Na obr. 2 jsou 

patrné intenzivnější paprsky v okolí vektoru „E“. Ty jsou právě způsobeny spekulárním 

odrazem. V tomto směru se budou přímo dopadající paprsky odráţet pod stejným úhlem, 

pod kterým na povrch dopadly. Spekulární reflexi lze zjistit jako součin intezity 

spekulárního odrazu, koeficient reflektance materiálu a dále n-tou mocninu součinu 

vektoru pohledu a vektoru spekulárního odrazu. Vektor spekulárního odrazu je vektor, 

který svírá s normálou stejný úhel jako vektor dopadajícího paprsku světla. Exponent „h“ 

určuje tzv. tvrdost odrazu. Tvrdý spekulární odraz bude menší a bude mít ostrý přechod. 

Čím bude mocnina menší, tím bude přechod intenzity spekulárního odrazu jemnější 

(vzorec 2.4). [13] 

 

Cs = Is . ka . (R . E)
h
 (2.4) 

kde Cs = difuzní osvětlení 

  Is = intenzita difuzního osvětlení 

  ka = koeficient odrazivosti materiálu 

  h = koeficient tvrdosti odrazu 
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Výsledný odraz je aproximací všech třech předešlých odrazů, tj. ambientního neboli 

okolního odraţeného světla, difuzního a spekulárního odrazu (vzorec 2.5). [13] 

 

C = Ca + Cd + Cs (2.5) 

kde C = výsledný odraz Phongova osvětlovacího modelu 

 

Kaţdému objektu na obr. 3 je přidělen materiál Phong s různými parametry. 

Všechny objekty mají přiřazenou vlastní barvu, červenou. První objekt zleva má 

nastavené pouze ambientním osvětlením.  Druhý naopak jen difuzní osvětlení. Další je jiţ 

kombinací ambientního a difuzního osvětlení. Poslední koule, zcela vpravo, je tvořena 

celým Phongovým osvětlovacím modelem, obsahuje tedy všechny předchozí osvětlení a 

navíc i osvětlení spekulární. Pro kaţdý druh osvětlení, resp. základních parametrů 

Phongova materiálu se vypočítává barva pro kaţdý jednotlivý vektor objektu. Z těchto 

údajů se poté aproximuje výsledné Phongovo osvětlení.  

 

 

Obr. 3 Porovnání objektů s různými typy odrazů 
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2.5 Zdroje světla v 3D grafice 

Prvním faktorem, jak bude vyrenderovaná scéna vypadat záleţí především na 

objektech, resp. na jejich materiálu, jeho vlastnostech a struktuře. Kvalita výsledného 

renderu bude samozřejmě ovlivněna pouţitím jiţ zmiňovaných technologií stínování a 

osvětlovacího modelu. Nemalou roli hraje správné nastavení parametrů renderingu. 

Důleţitým faktorem je bezesporu světlo. V 3D grafice se ustálilo několik typů světel, 

které simulují světelné zdroje pouţívané v reálném světě. Kaţdé světlo je určeno svojí 

polohou a směrová světla navíc normálovým vektorem, který udává směr záření. 

Kaţdému z následujících typů světel lze nastavit základní parametry, jako jsou barva 

světla a intenzita.  

Tím nejzákladnějším světlem je bodové světlo (point light). Je to bod v prostoru, 

který vyzařuje světlo rovnoměrně do všech stran. Tento zdroj patří mezi ty, které vrhají 

ostré stíny (viz. obr 4b). 

Plošné světlo (area light) je tvořeno konečnou plochou. Světlo je od toho zdroje 

emitováno do předního poloprostoru určeného vektorem. Plošné světlo vytváří měkké 

stíny, které jsou určené velikostí plochy světla a také vzdáleností světla od zdroje (viz 

obr.4a). 

 

a) b) 

 

Obr. 4 Porovnání (a) plošného světla a (b) bodového světla. [20] 
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Kuţelové světlo neboli reflektor (spot light) je v 3D grafice zastoupeno kuţelem. 

Směr u toho světla představuje osa kuţelu. Světlo je vyzařováno do kuţelového prostoru. 

Charakter světla lze ovládat velikostí podstavy a výškou kuţele.  

Rovnoběţný zdroj světla (directional light), který imituje slunce, je určen pouze 

směrem záření. Jeho pozice ve scéně nemá na osvětlení ţádný vliv. Lze si ho představit, 

jako nekonečně velkou a vzdálenou plochu vrhající pouze rovnoměrné paprsky. 

Okolní světlo (ambient light) ovlivňuje všechny objekty ve scéně stejně bez ohledu 

na to, jestli jsou objekty v přímé viditelnosti, tj. jestli na něj dopadají paprsky. Všude 

přítomné světlo ve scéně si lze představit, jako by existovala nekonečně velká koule, 

která by emitovala ve svém objemu světlo.  

V novějších verzích programů pro 3D grafiku se objevuje tzv. volumetric light, 

které do scény přidává efekt viditelných světelných paprsků, jako by světlo procházelo 

mlhou. [33]  

 

 

Obr. 5 Světelné zdroje v 3D grafice. [15] 
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3. RENDEROVÁNÍ V 3D GRAFICE 

3.1 Lokální a globální osvětlení 

a) b) 

 

 

Obr. 6 Porovnání (a) lokálního a (b) globálního osvětlení. 

 

Na obr. 6 je na první pohled zcela patrný rozdíl mezi lokálním a globálním 

osvětlením. U lokálního osvětlení (viz. obr. 6a) se při renderování počítá pouze s jedním 

odrazem paprsku. To znamená, ţe pokud se světelný paprsek při styku s předmětem 

neodrazí do místa pozorování, tak zaniká, tj. ve výsledku není vidět. V globálním 

osvětlení se mohou paprsky mnohonásobně odráţet, dále lámat, být pohlcovány a 

rozptylovat se. To má obrovský vliv na výpočetní a časovou náročnost. [12] 

3.2 Algoritmy výpočtu osvětlovacích modelů  

Jedním ze základních algoritmů slouţících pro výpočet osvětlovacích modelů je 

tzv. ray casting, v překladu vrhání paprsků. Metoda funguje na zcela odlišném principu 

neţ chování světla v přírodě. [11] Paprsky zde vycházejí z místa pohledu (kamery) a 

procházejí skrz imaginární obraz pohledu. Ten má dané rozlišení a je sloţen z pixelů. 

Paprsky jsou vrhány postupně kaţdým pixelem skrz mříţku a dopadají na scénu. Výpočet 

jediného pixelu probíhá následujícím způsobem. Z místa pohledu je skrz mříţku a daný 

pixel vedena imaginární přímka paprsku. [14] Paprsek sleduje svoji dráhu, dokud 

nenarazí na objekt nebo do doby, neţ je dosaţena hranice pro zánik paprsku. [8] Při 
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dopadu na objekt je do místa dopadu paprsku veden paprsek ze světelného zdroje. Tím se 

získá výpočet difuzního osvětlení 

Na obr. 7 jsou zobrazeny neprůhledné objekty, „A“, „B“ a „F“ a objekty 

s polopropustnými vlastnostmi, objekty „C“ a „D“. Objekt „E“ je na obrázku zobrazen 

jako ideální zrcadlo. 

 

a) b) 

 

Obr. 7 Schéma algoritmu (a) ray casting a (b) ray tracing. [9] 

 

Algoritmus ray tracing neboli sledování paprsku funguje na podobném principu 

jako ray casting. Emitovaný paprsek z místa pohledu se při styku s objektem můţe odrazit 

formou spekulárního odrazu nebo můţe dojít k refrakci na průhledném objektu. Při lomu 

se paprsek řídí tzv. Snellovým zákonem lomu [9]. Tento algoritmus je rekurzivní, a proto 

odraţené a lomené paprsky pokračují dále ve scéně. [14] Pro ně se celý cyklus opakuje. 

Ze schématu na obr. 7b je zřejmé, ţe výpočet pro jeden pixel bude ve sloţitějších scénách 

mnohem časově a výpočetně náročnější neţ u ray casting algoritmu. 
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4. POUŢITÝ SOFTWARE 

4.1 Autodesk Maya 2013 

Americká společnost Autodesk je součástí trhu s vývojem prostředí pro 3D grafiku 

a vizualizaci od roku 1982 a mezi její vůbec nejvýznamnější produkty patří průmyslový 

nástroj pro projektování a konstruování AutoCAD. [21] Aplikace Autodesk Maya (dále 

jen Maya) je profesionální software pro modelování a animaci 3D modelů, která se 

nejčastěji pouţívá ve filmovém průmyslu. Maya kromě modelování a animace umoţňuje i 

renderování scény, simulaci pouţitím efektových modulů a také kompozici videa, jako 

např. sledování pohybu, známé pod názvem camera tracking. První verze aplikace Maya 

vznikla v roce 1998 pro operační systém Windows. Za vývojem stála původně 

firma  Alias Systems Corporation, která software odprodala. [22] V současnosti je na 

software společnosti Autodesk poskytována studentská licence, pod kterou byl také tento 

projekt realizován. 

Modely lze v Maye vytvářet hned několika způsoby blíţe popsanými v části 

kapitoly 2.3.  Modelování je dále rozšířeno pomocí komponent nCloth, nParticle, fur, 

fluids a několika dalšími pro simulaci pohybu a chování např. látek, částic, chlupů a vlasů 

nebo kapalin. Díky tomu je moţné dosáhnout věrných animací např. ohně, kouře, tekoucí 

vody nebo vytvořit postavu včetně oblečení a vlasů ve vysokém rozlišení. 

Pro ukládání souborů pouţívá Maya dva vlastní datové formáty. Prvním z nich je 

formát Maya Binary, který pouţívá příponu MB. Druhý formát má příponu MA a jedná 

se o Maya Ascii. Rozdíl mezi těmito dvěma formáty je pouze ve způsobu nikoli v obsahu 

ukládané informace. Maya Ascii, jak jiţ vyplývá z názvu, reprezentuje data jako 

posloupnost znaků standardu ASCII. Výhodou je poté editovatelnost takového souboru. 

[23] Na rozdíl od toho formát Maya Binary ukládá informace přímo jako bity. Je tedy 

jasné, ţe posloupnost 0 a 1 lze jen těţko editovat. Ukládání a načítání souborů s příponou 

MB bývá zpravidla rychlejší na úkor abstraktní reprezentace dat v souboru. 

Maya má také svůj vlastní skriptovací jazyk MEL (Maya Embedded Language), 

který je syntakticky podobný Perlu. Pomocí skriptů lze dosáhnout stejných výsledků, jako 

sérií kroků provedených v GUI, resp. v grafickém prostředí aplikace. Některé postupy lze 

snáze vyřešit pomocí skriptů neţ běţným způsobem modelování. Takovým příkladem 

http://en.wikipedia.org/wiki/Alias_Systems_Corporation
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můţe být např. nakopírování objektu po křivce. Pomocí příkazů skriptovacího jazyka je 

moţné nahradit pracné manuální kopírování a zarovnávání objektu po křivce. [24] 

4.2 VRUT (Virtual Reality Universal Toolkit) 

VRUT je univerzální multiplatformní
1
 nástroj pro vizualizaci grafických dat a práci 

s 3D objekty. Aplikace VRUT vznikla na katedře Počítačové grafiky a interakce ve 

spolupráci s firmou Škoda Auto. K nezávislému jádru aplikace napsané v jazyce ANSI 

C++ je moţné přidávat moduly v podobě externích knihoven [17]. Jedním z modulů je 

ovládán pohyb kamerou a zobrazení scény pomocí knihovny OpenGL.  

Dalším modulem jsou získávány informace o materiálech a světlech modelu 

z vlastních zdrojových souborů s příponou GIRT. Samotná geometrie modelu je načítána 

ze souboru OBJ
2
, který reprezentuje 3D objekty.  Načítání dat z GIRT souborů umoţňuje 

pracovat a zobrazovat scénu technikou globálního osvětlení za pouţití ray tracingu
3
. Data 

jsou v GIRT souborech uloţena jako textový soubor s kódováním ASCII. Syntaxe 

vlastních datových souborů pro globální osvětlení je jednoduchá a pro oba GIRT soubory 

velice podobná. Proměnné, tedy např. popis konkrétního materiálu, jeho odrazové sloţky, 

popis světla apod., jsou uchovávány ve sloţených závorkách a vzájemně odděleny 

čárkou. Parametry těchto proměnných jsou inicializovány názvem parametru a hodnotou. 

Rozhraní pro práci s materiály a světly je sice textové, ale čisté. 

Aplikace se sestává z hlavního okna zobrazující scénu, panelu pro ovládání modulů 

a z panelu konzole, kde jsou vypisovány informace o průběhu aplikace, chybách a 

výjimkách v chodu programu. Konzolí je moţné vkládat instrukce.  

                                                 
1
 V současné době funguje aplikace pod systémy Windows a Linux. 

2
 Textový soubor s ASCII kódováním, který popisuje geometrie modelů, resp. polygonů, křivek a povrchů 

pomocí souřadnic. [16] 
3
 Blíţe specifikováno v části kapitoly 4.2. 
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5. REALIZACE PROJEKTU 

5.1 Postup realizace projektu 

Následující zjednodušený postup práce je popsán pro modelování v softwaru 

Autodesk Maya 2013. Některé postupy a názvy nástrojů se mohou od ostatních programů 

pro 3D grafiku lišit. Projekt byl vytvářen v několika na sebe logicky navazujících krocích. 

Na začátku bylo potřeba prostory změřit a obrazově zdokumentovat. Následně byl podle 

těchto podkladů vytvořen model, ke kterému byly postupně přiřazovány materiály. Po 

dokončení modelu byly parametry všech materiálů nastaveny, dle předpokladů o chování 

skutečných materiálů a také pomocí podkladových fotografií. Dále bylo vytvořeno 

osvětlení prostor. Na závěr, ještě před výsledným renderováním, proběhla optimalizace 

nastavení materiálů a světel.  

Při práci na poměrně rozsáhlém projektu jako byl tento, byla důleţitá správná 

organizace zdrojových souborů projektu. Z důvodů zálohování průběhu realizace v Maye 

byl při větších změnách v projektu vytvořen nový soubor (File > Save Scene As), ve 

kterém bylo později moţné dohledat a popř. exportovat části projektu. Takto průběţně 

ukládané soubory bylo nutné pojmenovat dle určených pravidel, která byla dodrţována 

během celé realizace. Název souboru se skládal z čísla iterace a nejdůleţitější prováděné 

změny, tj. aktuálního stavu projektu. Při práci na projektu se osvědčilo zálohování 

souborů na tzv. cloudové úloţiště, kterým je např. Dropbox. Způsob archivace na server 

umoţňoval dohledání předešlých stavů jednotlivých souborů. Pokud by v projektu došlo k 

nechtěné změně a soubor se před ukončením uloţil, existovala moţnost původní soubor 

dohledat. 

5.2 Měření a příprava podkladů k modelování 

Na počátku realizace projektu bylo třeba modelované prostory pečlivě změřit. 

K tomuto účelu byl pouţit laserový měřicí přístroj Bosch DLE 40 a digitální laserové 

pásmo Bosch PMB 300 L. Prostory chodby byly nejprve naskicovány a poté do nich byly 

během měření zapisovány hodnoty délky s přesností na jednotku milimetru. Laserovým 

měřidlem byly získány rozměry chodeb, výšky stropů, umístění dveří v prostoru, masivní 

dřevěné trámy a další k modelování nezbytné údaje. U nábytku jako jsou ţidle, stoly 
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apod. stačilo naměřit pouze jednu referenční hodnotu a ostatní hodnoty se jiţ odvíjely z 

fotografií nárysu, půdorysu a bokorysu. Ostatní detailní prvky jako např. elektrické 

zásuvky, kliky dveří apod. nebylo potřeba zakreslovat či měřit, protoţe modelování 

takovýchto objektů se odvíjelo od pořízených fotografií. Veliký důraz byl kladen na 

rozměry a především na rozmístění zářivek a světlovodů na chodbě a také na okna, 

kterými do podkroví proniká sluneční světlo (viz. obr. 8). Na preciznosti měření světel a 

oken závisel výsledek celé této práce. Nepřesnostmi by byla způsobena odchylka 

osvětlení modelu. 

 

 

Obr. 8 Podklady k modelování s naměřenými hodnotami. 

 

Nezbytnou součástí modelování byly podkladové fotografie pořízené digitálním 

fotoaparátem Canon EOS 40D. Nejprve byly získány fotografie ke zmapování celých 

prostor širokoúhlým objektivem. Dále byly nafoceny všechny prvky nacházející se na 

chodbě jako např. dveře, nábytek apod., které slouţily jako pomůcky k modelování. 

Fotografie slouţící jako podkladové pro modelování, byly pořízeny z největší moţné 

vzdálenosti pro minimalizaci sférického zkreslení. Současně byly v prostorách 

pořizovány podklady pro textury. U takových snímků byl kladen větší důraz na kvalitu 

fotografií, jejich výřez, ostrost a nastavení expozice fotoaparátu. Ne vţdy bylo moţné 

zachytit záběry zcela ideálně, a tak bylo u některých potřeba srovnat resp. natočit 

horizont, upravit sférické zkreslení nebo vyrovnat linie apod. K těmto účelům byl pouţit 
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software pro správu a úpravu fotografií a obrázků, Zoner Photo Studio. Specifickou 

úpravu vyţadovaly fotografie plakátů, které jsou na chodbě umístěné v plastových 

vitrínách. Při pořizování záběrů z ideálního místa, tj. přímo v ose plakátů, docházelo 

k silným odrazům na plastovém povrchu vitríny. V tomto případě nepomohl zamezit 

odrazům ani polarizační filtr a tak musely být záběry pořízeny z takového místa a pod 

takovým úhlem k povrchu vitríny, aby docházelo k minimálním odrazům. Takto získaný 

obrázek byl kvůli zkosení jako textura nepouţitelný a musel být před texturováním 

upraven (viz. obr. 9). Speciální úpravu vyţadovala textura regulátoru topení, která vznikla 

spojením čtyř fotografií pořízených jiné části regulátoru, jeho pootočením. Jiţ vytvořená 

nanesená textura je vidět na obr.  

 

a) b)  

 

Obr. 9 Úprava textur v aplikaci Zoner Photo Studio. (a) Původní fotografie. 

(b) Fotografie po úpravě, tedy připravená textura. 
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5.3 Modelování 

Při práci na modelu chodeb bylo pouţíváno především tzv. polygonální 

modelování, tedy způsobu práce, kdy jsou základní stavební prvky modelů
4
 

modifikovány. Existují tři základní transformace, které lze s těmito prvky provádět: (1) 

posun (translate), (2) otočení (rotate) a (3) změna velikosti (scale), resp. zvětšení či 

zmenšení. Většina modelů vznikla z primitivních tvarů
5
 (Create > Polygon Primitives), 

které byly následně různými nástroji transformovány do poţadovaných tvarů. Při 

modelování byla prioritou přesnost, které bylo dosaţeno buďto pouţitím naměřených 

hodnot, při vytváření nových objektů a jejich modifikaci, tedy zadáváním hodnot délky, 

šířky a hloubky v milimetrech nebo vloţením fotografie do scény (View > Image Plane > 

Import Image), podle které následně vznikal tvar objektu. Pokud nebylo moţné 

přizpůsobit rozměry modelovaného objektu ve scéně pomocí vloţené fotografie, tj. na 

fotografii nebyly zachyceny ţádné jiné jiţ vymodelované referenční objekty, podle 

kterých by ji bylo moţné zarovnat ve scéně, tak bylo potřeba vloţit podkladovou 

fotografii pořízenou z jiného úhlu nebo změřit některý z rozměrů objektu. Objekty 

vznikající při modelování bylo potřeba seskupovat do odpovídajících celků (Edit > 

Group). Pro přehlednost bylo nutné nově vznikajícím skupinám přiřazovat názvy podle 

řádu, který bude dodrţovaný v celém projektu. Scéna je rozdělena na několik větších 

celků tvořící hierarchii, prefix „ch1“ a „ch2“ sdruţuje všechny objekty nacházející se na 

jedné chodbě. Obdobně skupina s prefixem „k“ v názvu uchovává objekty, které jsou 

součástí podkrovní kuchyňky. Tyto tři části se dále dělí na další podskupiny objektů, jako 

je např. nábytek, okna, dveře, stropní lišty apod. (viz. obr. 10). Takto vytvořená stromová 

struktura objektů zvýšila přehlednost a zefektivnila práci s objekty, které jsou v GUI 

zobrazeny v tzv. Outlineru
6
.  

                                                 
4
 Stavebními prvky jsou polygony, vrcholy, hrany, blíţe popsané v části kapitoly 2.3. 

5
 Primitivními tvary jsou např. rovina, krychle, koule apod. 

6
 Outliner je část grafického prostředí aplikace Maya, která zobrazuje stromovou strukturu vytvořených 

objektů. 
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Obr. 10 Hierarchie objektů ve scéně. 

 

V průběhu modelování bylo často pouţíváno několik nástrojů, především nástroj na 

vloţení nové hrany po obvodu objektu, kolmo na existující hranu (Edit mesh > Insert 

Edge Loop Tool), dále nástroj na vloţení hrany na libovolné určené místo provedením 

řezu (Edit Mesh > Cut Faces Tool) a další. Dále bylo v průběhu realizace často pouţíváná 

funkce pro tzv. měkký výběr, který umoţňoval označit, rovnoměrně i nerovnoměrně dle 

zadaných parametrů v nastavení funkce, několik bodů, hran či plošek najednou, které 

mohly být následně transformovány.  

Základní kostru celého modelu tvořily stěny s podlahou a stropem. Podlaha byla 

vytvořena z roviny v šíři chodby, které byly následně vytahovány hrany (Edit Mesh > 

Extrude) dle rozteče bočních dveří chodby a jejich šířky a to následně usnadnilo 

zakomponování dveří do modelu chodby. Stěny byly vytaţeny stejným způsobem a nad 

úrovní dveří byly mezi vzniklými hranami vytvořené nové plošky pomocí nástroje bridge 

(Edit Mesh > Bridge). Všechny dveře modelovaných prostor se od sebe lišily jen 

nepatrně, coţ umoţnilo vytvořit jedny dveře, které mohly být několikanásobně 

zduplikovány (Edit > Duplicate). Před samotnou duplikací bylo vhodné mít ke všem 

částem kopírovaného objektu jiţ přiřazené materiály a vyhnout se tak nadbytečnému 

přiřazování materiálů k takto nově vytvořeným objektům a jejich částem. Rozmístění 

dveří na odpovídající místo v modelu podlahy bylo docíleno změnou pivota pohybového 

manipulátoru (Attribute Editor: Pivots – Local Space) a funkce přichycení k ostatním 
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objektům (Toolbar: Snap to Points). Všechny zkopírované objekty dveří, které se od 

primárních lišily, byly v několika krocích upraveny na poţadovaný vzhled. 

Přilehlá podkrovní kuchyňka vznikla obdobným způsobem. Vzhledem ke 

sloţitosti tvaru podkrovních stěn bylo po jejich vymodelování potřeba překontrolovat 

rozměry a úhel naklonění pomocí měřících nástrojů (Create > Measure Tools). Kdyţ byly 

tyto základy hotové, bylo nutné zkontrolovat orientaci normál polygonů (Display > 

Polygons > Face Normals). Pokud některé normály směřovaly ven z prostoru modelu 

chodby, byl jejich směr invertován (Normals > Reverse) tak, aby docházelo při 

renderingu ke správnému stínování. V průběhu modelování mohlo dojít k situaci, kdy 

jsou některé vrcholy polygonů zdvojené. Potom je nutné tyto vrcholy sloučit (Edit Mesh 

> Merge). Kdyţ byly hotové základy, mohly se začít modelovat lišty nacházející se v 

prostoru podél většiny stěn. Aby na sebe lišty vzájemně navazovaly, byly jejich 

zakončení detailně upravené (viz. obr. 11). Byly vymodelovány všechny potřebné 

kombinace zakončení ochranných lišt. Modely lišt byly poté na poţadovaná místa 

nakopírovány a rozměrově přizpůsobeny. 

 

 

Obr. 11 Detail různých zakončení modelů lišt. 

 

Stropní lišty, které se nachází na hlavních chodbách, vznikly obdobným způsobem. 

K vytvoření stropu byly pouţity primitiva roviny a válce. Na rovinnou plochu a válce, 

které reprezentovaly zabudovanou část světla, byla pouţita funkce odečtení (Mesh > 

Booleans > Difference). 
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Další důleţitou částí modelovaných prostor, bylo zařízení chodby, resp. nábytek. 

Jednoduché tvary objektů vznikaly běţnými a jiţ dříve popsanými technikami. U nábytku 

s neobvyklým tvarem, kterým byla sedací souprava a ţidle, bylo pouţito odlišných 

postupů. Asymetrické polštáře, které byly součástí gauče, bylo moţné vytvořit dvěma 

způsoby deformací. Prvním způsobem byla modulace normály [6], běţně známá pod 

anglickým výrazem bump mapping, která simuluje deformaci objektu tak, ţe změní 

polohu a směr natočení normálových vektorů polygonů podle daných parametrů, které 

bývají nejčastěji určené barevnými mapami. Tato varianta však neřešila problém, kdy se 

v místech dotyku polštáře s dřevěnou konstrukcí gauče polštář prohýbá. Proto byla 

pouţita druhá metoda, která umoţňovala kreslit štětcem po povrchu objektu tak, ţe 

měnila dle zadaných parametrů pozici jednotlivých vrcholů objektu (Mesh > Sculpt 

Geometry Tool). Dalším specifikem byly ţidle, ty měly totiţ zakřivený tvar nohou, které 

by bylo velmi obtíţné vytvářet z objektu primitivního tvaru pouze standartními 

transformacemi
7
. K takovým účelům poslouţila modifikace nástroje extrude, kterou lze 

vytáhnout tvar po křivce. Stačilo tedy vytvořit (Create > CV Curve Tool) a kruh a na oba 

objekty současně aplikovat tento nástroj. Totoţným způsobem byl vytvořen model např. 

hadice hasicího přístroje.  

Doplňky, které jsou také nedílnou součástí prostor, vznikaly jako poslední a opět 

podobnými způsoby modelování. V několika případech bylo vhodné pouţít deformační 

funkce, např. prohnutí (Create Deformers > Nonlinear > Bend) atd. U takových předmětů, 

které měly specificky opakující se tvar, např. ţebra topení apod. bylo vhodné pouţít 

speciální nástroj pro duplikování (Edit > Duplicate Special), kterým bylo moţné 

duplikovat objekty s přesně zadanou roztečí a v různých směrech, třeba i po kruţnici. 

                                                 
7
 Standartními transformacemi jsou translace, rotace a změna velikosti. 
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5.4 Materiály modelu 

 

Obr. 12 Přehled materiálů pouţitých v modelu. 

 

V projektu je pouţito na 131 různých materiálů, které jsou přiřazeny objektům ve 

scéně (viz obr. 12). Při vytváření materiálů byly pouţity pouze dva typy virtuálních 

materiálů, materiál typu Phong a mia_material_x. Phong byl pouţit na imitaci materiálů 

bez poţadavků na speciální vlastnosti odrazivosti. Tzn. na materiály, u kterých stačilo 

nastavit pouze ambientní, difuzní a spekulární odraz, zrcadlení a také exponent 

zrcadlových odlesků. Takové vlastnosti materiálů bezproblémově postačovaly např. na 

bílé stěny, dveře, materiál elektrických zásuvek apod. Dále byl ve většině případů 

Phongův materiál přiřazen objektům, které byly texturovány. To se týkalo různých 

plakátů, popisů dveří, dřevěných povrchů, jako např. stůl, ţidle, trámy nebo kuchyňská 

linka apod. Výjimkou z texturovaných materiálů byla jen podlaha, která vyţadovala 

důkladnější nastavení parametrů odrazu (viz. obr. 13). Pro tento případ byl vytvořen 

materiál mia_material_x, který je rozšířenou verzí jednotného materiálu mental ray pro 

renderování architektonických a designových objektů [27]. Dále bylo tohoto typu 

materiálu vyuţito pro broušené kovy na klikách dveří, kuchyňském dřezu a baterii a také 

několika dalších objektech. 
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Obr 13 Ukázka nastavení závislosti úhlu pohledu na odrazu: (vlevo) úhel pohledu 0 ° a 

nulový odraz. (vpravo) Úhel pohledu 90 ° a vysoká odrazivost materiálu. [27] 

 

Materiál okolí byl vytvořen tzv. skyboxem
8
, tedy nekonečně velkou koulí, na 

kterou byl namapován obrázek nebe. Tím bylo simulováno okolí, a při pohledu kamerou 

z okna se vykreslovala obloha. 

Součástí vytváření a přiřazování materiálů objektům byla také správnost nanesení 

textury na objekt. K tomuto účelu se ve 3D grafice pouţívá UV mapování
9
. Většina 

texturovaných objektů modelu byly ploché objekty, často tvořené jen rovinou, a proto na 

ně mohly být textury mapovány v rovině (Create UVs > Plannar Mapping). Na regulátor 

topení bylo pouţito mapování ve tvaru válce (Create UVs > Cylindrical Mapping). Pro 

mapování textur na sloţitější objekty bylo potřeba odpovídajícím způsobem upravit UV 

souřadnice, např. automatickým UV mapováním (Create UVs > Automatic Mapping) 

nebo některým nástrojem pro editování souřadnic textur (Edit UVs). 

 

                                                 
8
 Metoda, kterou je vytvořeno okolí, tak aby vypadala scéna větší, neţ ve skutečnosti je. 

9
 Metoda, která souřadnicemi U a V popisuje, jak bude 2D textura nanesena na 3D objekt. 



  

24 

 

 
 

Obr. 14 Render topení z modelovaných prostor s ukázkou válcovitého mapování 

textury. 

 

5.5 Osvětlení modelu 

Vytvoření realistických světelných podmínek v prostorách modelu chodby bylo 

posledním úkolem před syntézou obrazu. Společné prostory katedry Počítačové grafiky a 

interakce, které byly předlouho modelu, nasvěcovalo několik typů světel. Denní světlo do 

prostor pronikalo podkrovními okny a hlavní část chodby nasvěcovaly světlovody. Umělé 

světlo vytvářely zářivky pravidelně rozmístěné po celých délkách soustavy chodeb. 

Správná volba typů virtuálních světel a nastavení vstupních parametrů odpovídající realitě 

byl zdlouhavý proces. Postupným upravováním hodnot nastavení parametrů světel a 

porovnávání výsledků renderu části aktuálního záběru (Render > IPR Render Current 

Frame) bylo dosaţeno ideálních výsledků. Z důvodu autentičnosti byla upřednostněna 

metoda tvorby stínů pomocí ray  tracingu, před metodou vytváření stínů stínovou mapou, 

tím sice vzrostla kvalita vrhaných stínů, ale rapidně stoupl i čas potřebný k vytvoření 

renderu. Pro všechny vytvořená světla bylo nastaveno lepší vyhlazování pixelů tvořící 

stíny zvýšením počtu vrhaných paprsků aţ na 200 (Attribute Editor: mental ray > 

Caustics and GI > Shadow Rays).  
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Sluneční světlo bylo v modelu vytvořeno směrovým světlem (Create > Lights > 

Directional Light), které bylo pro tento typ záření typické. Parametry tohoto světla byly 

nastaveny tak, aby slunce osvětlovalo prostor podkroví, podobně jako na referenčních 

fotografiích. Přesto však chování tohoto světla neodpovídalo realitě, protoţe nevytvářelo 

tzv. „přepaly“ ve výklencích oken, kvůli dynamickému rozsahu
10

 fotografií. Z tohoto 

důvodu bylo do kaţdého okna umístěno jedno bodové světlo (Create > Lights > Point 

Light) s vysokým rozptylem, tj. vytvářející měkké stíny a s nejvyšším moţným, tj. 

kubickým (Decay - Cubic) úbytkem intenzity světla se vzdáleností od zdroje. 

 

a) b)  

 

Obr. 15 Porovnání světelných podmínek. (a) Scéna pouze se směrovým světelným 

zdrojem. (b) Scéna se směrovým světlem a přídavným bodovým světlem. 

 

Zářivky a světlovody byly vytvořeny bodovými světly a měly velice podobné 

nastavení parametrů, jen s tím rozdílem, ţe zářivky emitovaly více fotonů, tj. měly větší 

intenzitu světla a teplejší barvu, menší úbytek intenzity se vzdáleností (Decay - Linear) a 

niţší rozptyl paprsků (Attribute Editor: Raytrace Shadow Attributes > Shadow Radius). 

Faktorem, který přispěl k reálnosti vzhledu světel, bylo nastavení viditelné záře (Attribute 

Editor: Special Effects – Glow Intensity). 

                                                 
10

 Největší rozdíl jasů ve scéně změřený v EV jednotkách [18]. 
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5.6 Renderování modelu pomocí mental ray 

K vytvoření závěrečných renderů bylo pouţito renderer mental ray. Mental ray je 

samostatný software k vytváření fotorealistických obrázků, resp renderů. V mnoha 

grafických aplikacích, jako jsou Maya, 3D Studio Max, Cinema 4D a další, ve kterých 

bývá integrován jako jeden ze základních rendererů. Mental ray pouţívá k syntéze obrazu 

metodu sledování paprsku.  

Při nastavování parametrů rendereru byl vytvořen kompromis mezi kvalitou a 

časovou náročností výpočtu. Fotorealistických výsledků nebylo moţné dosáhnout bez 

pouţití globálního osvětlení. Dále byl v nastavení renderování povolen tzv. final 

gathering
11

. Kvalitu vytvořených obrázků také ovlivnily parametry nastavené v počtech 

rekurzivních odrazů při výpočtech metody sledování paprsku. Dále byly upraveny funkce 

sniţující artefakty v obrazu. Součástí ideálního přizpůsobení renderování bylo i povolení 

nastavení emitace fotonů ze zdrojů světel. 

5.7 Testování modelu v aplikaci VRUT 

V aplikaci VRUT dodané Katedrou počítačové grafiky a interakce pro vizualizaci 

byly simulovány světelné podmínky modelu. Před samotným testováním bylo nutné 

vytvořit zdrojové soubory, ze kterých VRUT načítá informace o modelu. 

Vyexportováním
12

 modelu z prostředí Maya vznikly soubory OBJ a MTL. Soubor 

popisující geometrii objektu, tedy OBJ, byl s aplikací kompatibilní tzn., ţe nepotřeboval 

ţádné dodatečné úpravy. Aplikace VRUT sice zobrazovala materiály popisované 

souborem MTL, ale bez moţnosti vyuţití globálního osvětlení. Proto byl vytvořen soubor 

materials.girt
13

, který to umoţňoval. Manuální všech vkládáním parametrů jednotlivých 

materiálů do GIRT souboru by bylo sloţité a neefektivní vzhledem k tomu, ţe materiály 

jiţ byly inicializovány v souboru MTL. Pro konverzi těchto formátů byl vytvořen skript 

v jazyce Java. Soubor MTL měl jasně danou strukturu pro ukládání informací o 

materiálech (příklad 1) a proto nebylo sloţité vyčítat data po řádcích, kontrolovat 

                                                 
11

 Final gathering je metoda, kterou lze dosáhnout realistických renderů. Funguje na principu, kdy při 

dopadu paprsku světla na objekt jsou emitovány náhodné paprsky do okolí, které při styku s dalším 

objektem získají část jejich energie, kterou pak jako příspěvek k vlastnímu odrazu vyzáří.[7] 
12

 Maya podporuje export do formátu OBJ, pokud je načtená knihovna objExport.mll (Windows > 

Settings/Preferences > Plug-in Manager). 
13

 GIRT soubory jsou blíţe popsány v části kapitoly 4.2. 
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inicializaci nového materiálu příkazem „newmtl“ a zapisovat parametry do nového 

souboru materials.girt (příklad 2). 

 

Příklad 1 Část souboru MTL. 

newmtl topeni_bilaSG 

illum 4 

Kd 0.96 0.96 0.96 

Ka 0.00 0.00 0.00 

Tf 1.00 1.00 1.00 

Ni 1.00 

Ks 0.17 0.17 0.17 

Ns 8.38 

 

 

Příklad 2 Část souboru materials.girt. 

{ 

name = topeni_bilaSG, 

type = 'phong_modified', 

 

ka = { 

type ='constant', 

 value = (0.00, 0.00, 0.00) 

}, kd = { 

 type ='constant', 

 value = (0.96, 0.96, 0.96) 

}, ks = { 

 type ='constant', 

 value = (0.17, 0.17, 0.17) 

}, shininess = { 

 type ='constant', 

 value = 8 

} 

} 
  

Materiály mia_material_x musely být do souboru GIRT pro materiály vloţeny 

jiným způsobem, protoţe je knihovna pro exportování do OBJ, resp. MTL 

nepodporovala. Byl zvolen postup manuálního vkládání těchto speciálních materiálů do 

souboru materials.girt. Existovalo sice řešení, které by tento proces zautomatizovalo, 
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pokud by byly pouţitím MEL skriptu převedeny na typ Phong, které by jiţ bylo moţné 

exportovat. Nebyl by však vyřešen problém se zrcadlovými a průhlednými materiály, 

které jsou v GIRTu specifikovány odlišně, parametry „mirror“ a „glass“. Výhodou 

manuálního zapisování těchto materiálů byla i současná optimalizace jejich parametrů při 

převodu do zdrojového souboru pro VRUT. Posledním poţadavkem funkčnosti materiálů 

bylo převedení souborů textur do formátu Targa
14

. 

Světla jsou v grafickém nástroji VRUT popsána v textovém souboru lights.girt 

obdobným způsobem jako materiály. Volba správných typů zdrojů světla s ohledem na 

reálné nasvícení modelu byla komplikovaná. Nejprve bylo otestováno nasvícení plošných 

světel, tzv. area lights, kdy bylo objektům reprezentující okenní sklo přiřazeno emitování 

světelných paprsků. Výsledky však ukázaly, ţe objekty, resp. polygony, na které 

nedopadají světelné paprsky, jsou naprosto černé, coţ neodpovídalo skutečnosti. Zvýšení 

ambientní sloţky odraţeného světla u všech materiálů nebylo řešení, protoţe intenzitu 

odraţeného světla vůbec neovlivnila (viz obr. 16a). Dalším pokusem řešení bylo přidání 

bodových světel, které v reálném prostoru ve skutečnosti nejsou, aby napomohly 

prosvětlit celý prostor a imitovaly tak ambientní osvětlení (viz obr. 16b). Výsledek byl ale 

opět neuspokojivý, protoţe stíny vrhané zdroji světla byly ostré a docházelo k odrazům, 

které se v prostorách vůbec nevyskytovaly. Konečným řešením problému bylo zvolení 

modelu stěn, jako samostatný světelný zdroj s velmi nízkou intenzitou záření (viz obr. 

16c). Kvalita obrazu se zvýšila, ale rapidně stoupla výpočetní náročnost syntézy obrazu 

(čas více jak 5 hodin
15

). Poté, co bylo nasimulováno a nalezeno ideální nastavení 

světelných zdrojů, vznikly obdobným způsobem i ostatní světla ve scéně. 

  

                                                 
14

 Formát s příponou TGA pouţívaný pro ukládání rastrové grafiky vhodný pro načítání textur. 
15

 Rendering probíhal na šestijádrovém procesu firmy AMD se základní frekvencí 3,8 GHz. 
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a) b) c) 

 

Obr. 16 Porovnání kvality a autentičnosti osvětlení (a) pouze plošnými světly 

umístěnými v oknech, (b) bodovými světly (c) a plošnými světly umístěnými v oknech 

v kombinaci se stěnami emitující světlo. 
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6. POROVNÁNÍ VÝSLEDKŮ 

 

 

 

Obr. 17 (nahoře) Fotografie (uprostřed) výsledek z mental ray (dole) výsledek z aplikace 

VRUT. 
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7. ZÁVĚR 

Výstupem práce je dle zadání především přesný model společných prostor Katedry 

grafiky a interakce ve 4. patře budovy FEL ČVUT na Karlově náměstí. Celý model je 

tvořený polygony s 445 571 body, 879 075 hranami a 436 274 ploškami. Objektům 

v modelu bylo přiřazeno 131 materiálů a pouţilo se 74 fotografií a obrázků pro textury. 

Součástí práce je také zdrojový soubor aplikace Autodesk Maya, coţ umoţňuje 

s projektem dále manipulovat, lze tak snadno např. přestavět rozmístění nábytku. Další 

práci s projektem usnadňuje především věcné pojmenování objektů ve scéně, které tak 

tvoří stromovou strukturu. Výhodou je tedy snadná orientace v projektu pro ostatní 

uţivatele. 

Písemná část práce byla pojata jako teoretické základy týkající se 3D grafiky a také 

obsahuje postup realizace, tedy jakýsi tutoriál, podle kterého je moţné dosáhnout stejného 

modelu. Jsou zde obecně popsány postupy při modelování, ale i nástroje a jejich umístění 

v grafickém prostředí Maya 2013, které byly během realizace pouţívané. Na přiloţeném 

DVD je umístěna i dokumentace skládající se z fotografií prostor, podle kterých byl 

model vytvořen, a z nákresů prostor s naměřenými hodnotami. Tyto podklady mohou 

pomoci při rekonstrukci moţné modelu. Součástí práce jsou i desítky přiloţených renderů 

z mental ray i z prostředí VRUT. 

Největším přínosem tohoto projektu je jeho vyuţití v aplikaci pro vizualizaci 

VRUT. Byly pro ni vytvořeny zdrojové soubory, které umoţňují kompletně zobrazovat 

model v tomto prostředí. Různými pokusy osvětlování modelu v aplikaci VRUT bylo 

zjištěno, ţe je moţné vykreslovat buďto obrázky velmi podobné realitě, ale s obrovskými 

nároky na výpočetní techniku, nebo pouţít takové osvětlení, které jiţ nevypadá 

realisticky, ale model lze snadno procházet. V této práci byl kladen důraz na autentičnost 

celého modelu a renderu a tomu odpovídal i čas potřebný k syntéze obrazu. Při realizaci 

tohoto projektu, resp. při testování modelu v aplikaci VRUT byly odhaleny některé jeho 

nedostatky, nicméně je to u programů, které jsou stále ve vývoji a probíhá na nich 

testování, běţné. Následující připomínky jsou tedy spíše zpětnou vazbou. Bylo zjištěno, 

ţe při procházení modelu ve směru vpřed došlo v jistou chvíli k „zamrznutí“ pozice 

kamery. Tím byla ztíţena práce při kompozici záběru ve scéně. Další podnětem 

k implementaci VRUT je moţnost nastavení parametrů ambientní sloţky materiálu nebo 
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moţnost vloţení ambientního světla do scény. Na druhou stranu jsou výstupy z aplikace 

VRUT více neţ uspokojivé a rendery se, co se týče materiálů i osvětlení blíţí realitě. 

Na projekt je moţné navázat jeho pouţitím v rozšířené realitě, zmíněné v zadání 

práce. Připadá v úvahu i jeho moţné další rozšíření do dalších prostor, a nebo vyuţití 

některých objektů v rámci jiných projektů.  
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PŘÍLOHA A 

Ukázka modelů 

 

Obr. A1 Model gauče. 

 

 

Obr. A2 Modely barové ţidle. 
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Obr. A3 Model stolu typu 1. 

 

 

Obr. A4 Model stolu typu 2. 
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Obr. A5 Model topení a jeho detaily. 
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Obr. A6 Model kuchyňská linka a dřezu. 

 

 

Obr. A7 Model mikrovlnné trouby. 
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PŘÍLOHA B 

Výstupy z rendereru mental ray 

 

Obr. B1 Pohled do části podkroví. 

 

 

Obr. B2 Pohled do části podkroví. 
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Obr. B3 Pohled do části chodby nazvané „ch1“. 

 

 

Obr. B4 Pohled do části chodby nazvané„ch1“. 
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Obr. B5 Pohled do části chodby nazvané „ch2“. 

 

 

Obr. B6 Technická zařízení a hasicí přístroj. 
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Obr. B7 Detail podkrovního okna. 

 

 

Obr. B8 Kuchyňská linka s dřezem. 
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Obr. B9 Pohled do části podkroví. 

 

 

Obr. B10 Barové ţidle. 
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Obr. B11 Část gauče. 

 

 

 

Obr. B12 Část stolu, elektrická zásuvka. 
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PŘÍLOHA C 

Výstupy z aplikace VRUT 

 

Obr. C1 Pohled do podkroví. 

 

 

Obr. C2 Pohled do podkroví. 
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Obr. C4 Pohled do podkroví. 

 

 

Obr. C5 Pohled do podkroví 
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Obr. C6 Pohled na kuchyňku. 

 

 

Obr C7 Gauč se stolkem. 
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PŘÍLOHA D 

Seznam pouţívaných zkratek 

FEL Fakulta elektrotechnická 

ČVUT České vysoké učení technické 

DCGI Katedra počítačové grafiky a interakce 

VRUT Virtual Reality Universal Toolkit 

2D dvoudimenzionální 

3D trojdimenzionální 

MA Maya Ascii 

MB Maya Binary 

GI Global Illumination 

TGA Targa 

OBJ object file 

MTL Material Library File 

PDF Portable Document Format 

MS Microsoft 

EV exposure value 

GUI Graphical User Interface 

OpenGL Open Graphic Library 

ASCII  American Standard Code for Information Interchange 

IPR Interactive Photorealistic Rendering 
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PŘÍLOHA E 

Obsah přiloţeného DVD 

Obsahem přiloţeného DVD je: 

 

 Documentation 

 Measurement – adresář obsahující nákresy prostor s měřením 

 Model pictures – adresář obsahující obrázky drátěných modelů 

 Photos – adresář obsahující fotografie modelovaných prostor 

 Models 

 Maya 

 Scene.ma – model v projektu aplikace Maya 

 Textury – adresář obsahující data pro textury 

 VRUT 

 Scene.obj – zdrojový soubor pro VRUT geometrií modelu 

 Scene.mtl – soubor s materiály 

 lights.girt – zdrojový soubor pro VRUT s osvětlením 

 materials.girt – zdrojový soubor pro VRUT s materiály 

 Scene_VRUT.ma – model optimalizovaný pro VRUT 

 Textury – adresář obsahující data pro textury 

 MTL Converter 

 MTLConverter.java – skript pro převod Scene.mtl na materials.girt 

 Readme.txt – instrukce ke skriptu 

 Renders 

 Mental ray – adresář obsahující výstup (rendery) z mental ray 

 VRUT – adresář obsahující výstup (rendery) z aplikace VRUT 

 Text – adresář obsahující texty bakalářské práce v MS Word a v PDF 


